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• Introduction •

Overview
Crystal Reports for Peachtree is a special version of the popular Crystal Reports® 
report writer designed to work with Peachtree. The program is powerful yet 
flexible, letting you customize reports using virtually any of the information 
available in your company database.

Crystal Reports for Peachtree comes with several predesigned reports that small 
businesses find useful. If you want to design your own reports, the program 
automates the design process, providing a Report Expert that will guide you step 
by step. But for those special cases where a report requires a unique design, the 
Report Designer lets you put together text (such as headers or titles), maps or 
graphs, images (such as company logos), and of course database elements just 
as you want them to appear on the printed report. Then you can preview the 
report to make sure it looks as you expect.

What’s in This Guide

The Crystal Reports for Peachtree Getting Started Guide includes the following 
sections:

Chapter 1: Introduction This chapter contains installation instructions, a 
program overview, a brief description of the twelve standard Crystal reports, 
and a section devoted to using the program in a network environment.

Chapter 2: Previewing Crystal Reports This provides a discussion and 
illustration of the standard reports included with the program. It also tells you 
how to preview these reports using the Crystal Viewer.

Chapter 3: Designing Crystal Reports: A Tutorial This briefly describes the 
Crystal Report Designer and discusses how Crystal reports incorporate your 
Peachtree database information. Then we walk you through the process of 
modifying and designing Crystal reports:

• In Lesson 1 you learn how to change the Crystal inventory labels into 
price tags. 

• In Lesson 2 you learn how to create a customer contact list from 
scratch.

• In Lesson 3 you learn how to use the Crystal Report Expert to design a 
list of customer quotes filtered by expiration date.

Chapter 4: Upgrading Crystal Reports to Version 9 This includes 
instructions that will help you make sure your Version 8 Crystal custom reports 
work in Version 9 and in Peachtree 2004.
2



Installing Crystal Reports for Peachtree
Install the Evaluation Version of Crystal Reports
Chapter 5: Linking Report Tables in Crystal Reports Because Version 8 and 
Version 9 of Crystal Reports Smart Link tables differently, this chapter discusses 
the tables used in generating Crystal reports and fields that should be used to 
link them in Version 9.

Appendix: Filtering Report Data Finally, here you’ll learn which tables and 
fields are especially useful in building Crystal reports. You’ll also learn how to 
filter reports to eliminate the return of null values in report data.

The guide you are reading is only a supplement to the Crystal Reports User’s 
Guide, which comes with the Crystal Reports for Peachtree program, either in a 
printed or online (PDF) version. For detailed information on working with the 
program, consult this guide. When additional information is available in the 
Crystal Reports User’s Guide, we will cross-reference it. The Crystal Reports for 
Peachtree program also comes with an extensive online Help system (referred to 
in this guide as Crystal Reports Online Help), and we will occasionally reference 
this online Help as well. So be sure to watch for cross-references as you read.

Installing Crystal Reports for Peachtree
Following are brief instructions for installing both the evaluation version and 
permanent version of Crystal Reports for Peachtree. For more information on 
installation, refer to the Crystal Reports User’s Guide.

Install the Evaluation Version of Crystal Reports

If you own Peachtree Accounting or Peachtree Complete Accounting, the 
Peachtree installation CD comes with an evaluation copy of Crystal Reports for 
Peachtree. This version can be used for thirty days after installation, at which 
time you must upgrade to the permanent version in order to keep working with 
Crystal Reports.

Use the following procedure to install Crystal Reports.

1 Insert the Peachtree installation compact disc in your CD-ROM drive.

The Crystal Reports Autorun window automatically appears. 

2 Click the Crystal Reports for Peachtree install option.

If the Peachtree Autorun window does not automatically appear, do the 
following: From the Windows Start menu, select Run. Type x:autorun 
and press Enter (where x: is your CD-ROM drive designation).

3 Follow the prompts to install Crystal Reports for Peachtree.

Note
3
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The Select Installation Type window lets you choose either a typical or 
custom installation of Crystal Reports. Generally, you will want to choose 
the Typical option, but for more information on custom installation, refer 
to the Crystal Reports User’s Guide, the section on installation.

The default installation path (destination folder) for the program is 
C:\Program Files\Crystal Decisions\Crystal Reports for Peachtree. 
However, you can change this path if desired during installation. In the 
Select Installation Type window, use the Browse button to choose another 
installation path.

4 When finished with the Select Installation Type window, click the Next 
button to continue.

5 Once installation is complete, click the Finish button to close the window.

Install the Permanent Version of Crystal Reports

If you own Peachtree Premium Accounting or Peachtree Premium Accounting 
Accountants’ Edition, your Peachtree installation CD includes the permanent 
version of Crystal Reports for Peachtree. No upgrading will be necessary except 
for upgrading to new releases of the software.

Besides Crystal Reports, the Peachtree installation CD allows you to install PDF 
versions of the Crystal Reports for Peachtree User’s Guide and Getting Started 
Guide. Since these PDF files require Adobe Acrobat Reader, the CD includes as 
well a copy of Release 5 of Adobe Acrobat Reader

You can accept the
default destination folder

for installing Crystal
Reports for Peachtree or

use the Browse button to
select a different one.
4
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Following Installation...
Install Crystal Reports for Peachtree

1 Insert Peachtree installation compact disc in your CD-ROM drive.

The Peachtree Autorun window automatically appears. 

2 Click the Crystal Reports for Peachtree install option.

3 Follow steps 3 through 5 under “Install the Evaluation Version of Crystal 
Reports” on page 3.

Install Adobe Acrobat Reader

To display and use the Crystal Reports PDF documents, you must have Adobe 
Acrobat 5 (or higher) installed on your computer. Adobe Acrobat Reader can be 
installed from the Crystal Reports installation CD or downloaded for free at 
www.adobe.com.

Use the following procedure to install Adobe Acrobat Reader from the CD.

1 Insert the Peachtree installation compact disc in your CD-ROM drive.

The Peachtree Autorun window automatically appears. 

2 Click the Adobe Acrobat Reader install option.

3 Follow the prompts to install Adobe Acrobat Reader. 

Display the User’s Guide or Getting Started Guide

To display the two PDF documents provided on the installation CD:

1 Insert the Peachtree installation compact disc in your CD-ROM drive.

The Peachtree Autorun window automatically appears. 

2 In Windows Explorer, browse to the \Doc folder on the CD. The two guides 
are in this folder.

3 Double-click a document to open it in Adobe Acrobat Reader.

Following Installation...

Once the Crystal Reports for Peachtree program is installed, you can launch it 
directly—either from the icon on your desktop or from the Windows Start 
menu—to design, edit, and print all types of reports required by your business. 
For added convenience, you can also access the program while working in 
Peachtree. See the illustration of the Peachtree Reports menu on page 8.
5
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The Standard Crystal Reports

Version 8 Standard Reports

Crystal Reports for Peachtree Version 8 comes with six standard, predesigned 
reports.

• Customer Detail List—This lists a variety of formatted detail 
information about your customers.

• Customer Sales by Item—This lists stock items your company has 
sold in the current accounting period and the customers who have 
bought them. The list is sorted by item rather than by customer.

• Inventory Labels—These are for marking inventory items so they can 
be stocked in their proper location. The labels print on standard 
3 across x 10 down label forms.

• Purchases by Unit Price—This lists, for the current accounting 
period, unit prices of stock and non-stock items you have purchased 
and the vendors who sold them. The list is sorted by item rather than 
by vendor.

• Vendor Detail List—This lists a variety of formatted detail 
information about your vendors.

• Void Check Register—This shows only your company checks, for the 
current accounting period, that have been voided.

Version 9 Standard Reports

Crystal Reports for Peachtree Version 9 comes with six additional, predesigned 
reports. Each of these reports has the marker “v9” in the report name (for 
example, “Aged Payables v 9”) to indicate the version number. In fact, in 
Version 9, all twelve reports will have the “v9” marker since all will be in Version 
9 format.

• Aged Payables—This shows a total of aged payables by vendor. It also 
includes basic information for each vendor taken from the Peachtree 
vendor record.

• Aged Receivables—This shows a total of aged receivables by 
customer. It also includes basic information for each customer taken 
from the Peachtree customer record.

• Customer Balance Graph—This is a bar graph that shows balances by 
customer. It also includes basic information for each customer taken 
from the Peachtree customer record.
6



The Standard Crystal Reports
Where the Reports Are Stored
• Customer Sales by Month—This lists all customers of your company 
alphabetically and lists amounts sold to them by month. The report is 
displayed in spreadsheet form and is taken from the data contained in 
the Peachtree Sales Journal.

• Items Sold by Month—This lists, alphabetically by ID, all stock items 
sold by your company each month. The report is displayed in 
spreadsheet form and is taken from the data contained in the Peachtree 
Sales Journal.

• Vendor Balance Graph—This is a bar graph that shows balances by 
vendor. It also includes basic information for each vendor taken from 
the Peachtree vendor record.

Where the Reports Are Stored

When you install the Crystal Reports for Peachtree program, these twelve 
reports are automatically copied to all of your company subdirectories. So, for 
example, if you have five companies in Peachtree, the standard reports will be 
copied to each of the five company subdirectories. In addition, a Zip file 
containing the twelve standard reports is automatically copied to your 
Peachw/Reports directory; the name of this file is REPORTS.ZIP. 

If you alter or delete the original standard reports, you can always Unzip this file 
and copy the reports to your company subdirectory, where you’ll be able to 
access them in Peachtree. In order to Unzip the file, you will need a copy of the 
WinZip® program installed on your computer. You can download an 
evaluation version of the program from the Internet at www.winzip.com.

When you create custom reports or when you download new standard reports 
from the Peachtree Web site, you must always copy them to your company 
subdirectories before you can work with them in Peachtree.Note
7
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How to Access the Reports

As with all Peachtree reports, you can access the standard Crystal reports from 
both the Reports menu...

...and from the Select a Report window, shown below listing standard Crystal 
reports with Version 8 of Crystal Reports for Peachtree installed.

The Crystal Reports
option opens the

Select a Report
window with the

Crystal Reports area
preselected

(highlighted); see the
illustration below.

The Crystal Reports
Designer option
opens the Crystal

Reports for Peachtree
program, where you
can select an existing

report or design a
new one.

Note: Time/Expense 
reports are available only 
in Peachtree Complete 
and Peachtree Premium 
Accounting.
8
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How to Access the Reports
The window looks like this if you have Version 9 of Crystal Reports installed. 
Note that Version 9 standard reports are marked with a “v9.” (Note also that 
Version 8 standard reports existed in the company folder before the installation 
of Version 9, so these Version 8-format reports remain and aren’t marked 
“v 9.”)

You can select a Crystal report from the Report List just as you would any 
Peachtree report. If you right-click on a selected Crystal report in the list, you 
will see a popup menu featuring Print, Preview, Design, and What’s This? 
Help options.

• For more information on using the Print option, look up “Print dialog 
box” in the Crystal Reports Online Help index. See also the 
“Introduction to Reporting” chapter in the Crystal Reports User’s 
Guide.

• For information on using the Preview option, see “Previewing Crystal 
Reports” on page 19 of this guide.
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• For more information on using the Design option, look up “Design 
tab” in the Crystal Reports Online Help index. See also the 
“Introduction to Reporting” chapter in the Crystal Reports User’s 
Guide.

• For more information on selecting reports and working in the 
Peachtree Select a Report window, see the Peachtree User’s Guide, the 
“Reports” chapter.

Important: If you are using Crystal Reports for Peachtree Version 8 but have 
upgraded to Peachtree 2004, you will need to upgrade your custom reports to 
work with Peachtree. Similarly, if you have upgraded to Crystal Reports for 
Peachtree Version 9 for use with Peachtree 2004, you will have to upgrade any 
custom reports created in Version 8 before you can work with them in 
Peachtree. For information on upgrading custom reports, see the “Upgrading 
Crystal Reports to Peachtree 2004” chapter in this guide.

Using Crystal Reports in a Network
If you are working in a network environment, special conditions apply for the 
Crystal Reports for Peachtree program.

Special Network Conditions

The program must be installed on all machines The program needs to be 
installed on all networked machines where it will be used; the program will not 
work properly if installed on and accessed from a central server. 

Consult your license agreement for information about the number of machines 
on which Crystal Reports can be installed.

So that more than one person can have access to Peachtree data and Crystal 
reports, you can copy these to a central server. Say you store your Peachtree data 
on drive E on the server. The data path to your Peachtree data is 
E:\PEACHW\DATA, and the data path to your company data is 
E:\PEACHW\<COMPANY>, where <COMPANY> is the name of the folder 
where your company files are located. Into this folder you should copy all 
Crystal reports that apply to the company. 

Now all machines with access to the data path E:\PEACHW on the server will 
have access to both Peachtree data and Crystal reports. For more information 
about sharing Peachtree data in a network environment, look up “Network: 
About Peachtree in a Network Environment” in Peachtree Help.

Note

Note
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Limit Data Access to One User
Standard Crystal reports are read-only When Peachtree is installed, the 
standard Crystal reports described in this chapter are installed as read-only files 
in all company subdirectories. This means that anyone working in the Crystal 
Reports for Peachtree program will be able to preview the reports but will not 
be able to edit and then save them. That way, you will always have the standard 
reports in their original condition so you can use them as templates for custom 
Crystal reports. 

If you are working in Crystal Reports for Peachtree and try to edit and then save 
a standard report, you will see an error message stating “This report could not 
be opened for writing. Any changes must be saved to a new file.” 

If you want to save your changes, use the Save As option on the File menu to 
save the file under a new name. Once saved, this new custom report will be fully 
editable.

Write access is limited to the first user only When you create new custom 
Crystal reports based on the standard ones, you will be able to edit and save these 
new reports as desired. However, if more than one person is working with the 
same custom report in Crystal Reports for Peachtree, only the first user to access 
the report will have “write access”—that is, be able to edit and save the report. 
All other users will have read-only access and will be able only to view and print 
but not save the report, whether in preview or in design mode.

Limit Data Access to One User

Through Maintain Users, Peachtree allows you to set up user passwords and 
limit access to areas of the program. If desired, you can limit access to Crystal 
Reports for Peachtree, at least for design purposes, to only one user. To give just 
one user data access to Crystal Reports, enter a maximum eight-character 
password for that user, and then select the Limit data access from Crystal 
Reports to this user only check box.
11
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Now, all users will be able to preview or print a Crystal report. However, when 
any user tries to refresh the data in a Crystal report using the Refresh button in 
the Standard tool bar, the program will request a password. If the password 
entered does not match the password set up for one-user access, then the user 
will not be able to refresh the report data and thus potentially use different 
parameter values to filter the data that appears in the report.

For more information about the Maintain Users window and setting up 
users, click the Help button in the window. See also the Peachtree User’s Guide, 
the “Company Administration” chapter. For more information about 
refreshing report data in Crystal, look up “Refreshing data:report data” in the 
Crystal Reports Online Help index.
12
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• Previewing Crystal Reports •
This chapter describes and illustrates the standard reports that come with the 
program. It also tells you how to preview reports using the Crystal Viewer and 
provides an overview of report printing.

Standard Crystal Reports, Version 9
Version 9 of Crystal Reports for Peachtree is shipped with the following twelve 
reports. All standard reports shipped with Version 9 have the marker “v9” in the 
report name (for example, “Aged Payables v 9”) to indicate the version number.

Aged Payables

This report shows a total of aged payables by vendor. It also includes the 
following information for each vendor taken from the Peachtree vendor record:

• Vendor ID

• Vendor Name

• Contact

• Telephone (No. 1)

• Invoice/Credit Memo No.

• Aging Brackets

Aged Receivables

This report shows a total of aged receivables by customer. It also includes the 
following information for each customer taken from the Peachtree customer 
record:

• Customer ID

• Customer Name

• Contact

• Telephone (No. 1)

• Invoice/Credit Memo No.

• Aging Brackets
14
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Customer Balance Graph
Customer Balance Graph

This bar graph shows balances by customer. It also includes basic information 
for each customer taken from the Peachtree customer record. The graph itself 
shows customer balances along the vertical axis and lists customer IDs along the 
horizontal axis. The following information for each customer is listed below the 
graph:

• Customer ID

• Customer Name

• Contact

• Telephone (No. 1)

• Customer Balance

Customer Detail List

This report lists detail information about customers you have added to 
Peachtree through Maintain Customers/Prospects. It includes the following 
information for each customer:

• Customer ID and name

• Bill-to and ship-to addresses

• Contact Person

• Phone Number 1 and 2

• Fax Number

• E-mail Address

• Web Address

• Prospect (yes/no)

• Customer status (active/inactive)

• Customer Type

• Customer Since date

• Tax location

• Resale Number

• Open purchase order number

• Credit Limit

• Pricing Level

• GL Sales Account
15
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• Sales Rep Name

• Sales terms

• Sales Tax ID

• Last Invoice Date

• Last Invoice Number

• Last Payment Date

• Last Payment Amount

• Last Statement Date

• A listing of all custom fields

Customer Sales by Item

This report lists stock items sold and the customers sold to within a selected date 
range. The report is sorted by item rather than by customer. It includes the 
following information:

• Inventory ID and Description

• Customer ID

• Date of sale

• Invoice number

• Quantity sold

Customer Sales by Month

This report lists all customers of your company alphabetically and lists amounts 
sold to them by month. It is based on data contained in the Peachtree Sales 
Journal.

The report is displayed in cross-tab or spreadsheet format. Along the vertical 
axis it lists customers by ID, and along the horizontal axis it lists all accounting 
periods covered by the report (up to 26 periods).

Inventory Labels

These are labels you place on items so that they can be stocked in the proper 
location at your storage facility. The labels print 3 across x 10 down (30 per 
page) in the LL-30W laser label format available through the Peachtree Business 
Checks & Forms catalog. Each label lists the following information:
16
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• Item ID

• Item description

• Vendor ID

• Location

The labels print 30 per page in the LL-30W laser label format available through 
the Peachtree Business Checks & Forms catalog. 

For ordering information, consult the catalog or look up “Peachtree Checks and 

Forms” in Peachtree Help.

Items Sold by Month

This report lists, alphabetically by ID, all stock items sold by your company each 
month. It is based on data contained in the Peachtree Sales Journal. 

The report is displayed in cross-tab or spreadsheet format. Along the vertical 
axis it lists items by ID, and along the horizontal axis it lists all accounting 
periods covered by the report (up to 26 periods).

Purchases by Unit Price

This report lists the unit prices of stock and non-stock items purchased and 
vendors purchased from within a selected date range. The report is sorted by 
item rather than by vendor. Use the report to check which vendors are offering 
the best pricing on an item.

The report includes the following information:

• Item ID and Description

• Date of purchase

• Vendor ID

• Invoice number

• Quantity

• Unit price

• Total purchase amount
17
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Vendor Balance Graph

This is a bar graph that shows balances by vendor. It also includes basic 
information for each vendor taken from the Peachtree vendor record. The 
graph itself shows vendor balances along the vertical axis and lists vendor IDs 
along the horizontal axis. The following information for each vendor is listed 
below the graph:

• Vendor ID

• Customer Name

• Contact

• Telephone (No. 1)

• Vendor Balance

Vendor Detail List

This report lists detail information about vendors you have added to Peachtree 
through Maintain Vendors. It includes the following information for each 
vendor:

• Vendor ID and name

• Address

• Contact Person

• Fax Number

• E-mail Address

• Web Address

• Phone Number 1 and 2

• Fax Number

• Vendor Type

• Federal ID Number

• Vendor Since date

• Company account number

• Balance

• Credit Limit

• Purchase Account

• Terms

• A listing of all custom fields
18
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Void Check Register

This report lists all disbursement and payroll checks that have been voided 
within a selected date range. it includes the following information:

• Check number

• Void date

• Payee (employee name, vendor name, or customer name)

• Cash account

• Check amount

This report lists, alphabetically by ID, all stock items sold by your company each 
month. It is based on data contained in the Peachtree Sales Journal. 

The report is displayed in cross-tab or spreadsheet format. Along the vertical 
axis it lists items by ID, and along the horizontal axis it lists all accounting 
periods covered by the report (up to 26 periods).

Previewing Crystal Reports
The standard reports that come with Crystal Reports for Peachtree are designed 
to open in preview mode. This is so you can preview them when you select them 
either in the Peachtree Select a Report window or in Crystal Reports’ Report 
Designer. The Save data with report option in the Crystal Reports File menu is 
turned on for each of the six standard reports; this is what allows them to be 
previewed. 

Set Up Reports to Appear in Preview Mode

If you turn off the Save data with report option and then save a standard report, 
when you open it again either in Peachtree or in Crystal Reports, the report will 
open in design rather than preview mode. So if you want the standard reports to 
open in preview mode, be sure to leave the Save data with report option turned 
on. With the option turned on, you can preview a Crystal report the same way 
you do other Peachtree reports. 

Do one of the following:

• click the name of a Crystal report in the Select a Report window and 
then click the Preview button

• double-click the report name with the left mouse button
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The Crystal Design window appears with the report displayed on the Preview 
tab.

For more information on using the Crystal Reports for Peachtree Preview 
tab, look up “Preview Tab” in the Crystal Reports Online Help index. See also the 
Crystal Reports User’s Guide, the “Introduction to Reporting” chapter.

A Note about Printing Standard Crystal Reports

All standard Crystal reports are set up with no default printer chosen. So when 
you print using either the Print button in the standard toolbar or the Print 
option in the File menu, Crystal Reports for Peachtree will display a message 
telling you that no printer has been configured for the current report.
20
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• To print the report using the default printer you have set up with the 
Windows Settings>Printers option, select Yes.

• To print printer the report with a different printer, select No.

Note that the No Printer check box is checked, indicating there is no printer 
configured for this report.

You can clear the No Printer check box, and then using the Name drop-down 
list, select a printer to use for printing the report. Set any other print attributes, 
such as double-sided printing, using the Properties button.

Clear the No Printer
check box...

...select the printer
your want to use.

If desired, you can
always reset the

printer to the default
one.

Use the Properties 
button to set any 
special print 
attributes, such as 
double-sided printing.
21
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You can always reset the printer to the default one, in which case the standard 
Print window will appear, letting you choose a variety of print options, 
including a range of pages to print, the number of copies to print, and whether 
or not you want those copies collated.
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• Designing Crystal Reports:
A Tutorial •

Overview
When you design a Crystal report, you have a choice of either manually selecting 
the elements that will go into it or of automating the design process by using 
Crystal Reports for Peachtree’s Report Experts. Through a series of tabbed 
windows, the Report Experts guide you in every step of the design process. If you 
want to manually construct the report, Crystal’s Select Expert, Formula Expert, 
Section Expert, and Format Editor will help you choose exactly which data 
elements and formatting you want to appear in the report. 

Information on how to use these special features is beyond the scope of this 
guide. Instead, see the Crystal Reports User’s Guide, or look up the name of the 
specific feature in Crystal Reports online Help. However, in this chapter we give 
you an introduction to some of Crystal’s design features in the form of a brief 
tutorial that walks you through the process of designing your own Crystal 
reports. We also show you how to customize one of the standard reports that 
come with Crystal Reports for Peachtree. After completing the tutorial, you’ll 
have a better idea of how Crystal works and how to get your reports to include 
the precise data and formatting you want them to.

Before we start the tutorial, we explain some terms that will help you understand 
how Crystal reports incorporate database information; then we tell you how to 
add and link database information in a Crystal report.

Data Dictionaries

A data dictionary is a structured, simplified, and secure view of organizational 
data that an employee can use to create custom reports for your company. A 
dictionary gives the employee ready access to the data in an understandable 
form while ensuring control and security over your data resources, since the 
employee can in no way alter the original data. Using a dictionary, the employee 
can

• design a single, dynamic view of all the data that is necessary to create 
organizational reports and queries

• include multiple data sources, tables, and links 

• organize the data and rename tables and fields to make it easier for 
company employees to understand the content and purpose of the data 

• limit access to specific columns of data (for example, letting only 
managers see the salary column of the employee data files) 
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• place restriction formulas on specific rows of data (for example, 
allowing managers to view employee information only for those 
employees with a salary under $40,000)

• create complex data-manipulation formulas that employees can access 
without requiring a technical grasp of the formulas

Data Dictionary Files (DDFs)

Each data dictionary is made up of data dictionary files (DDFs). Crystal Reports 
for Peachtree comes with a special dictionary made up of three DDFs that 
contain much of the company information you would want to include in your 
reports. These three DDFs are called Field.DDF, Index.DDF, and File.DDF. 
(Note that while the program comes with three DDFs, you should make use of 
just the file called File.DDF—more about this below.)

In turn, each of these DDFs contains a series of subfiles with a .DAT extension. 
These subfiles contain a variety of company database information in the form of 
fields. For example, one .DAT file called Company.DAT contains fields that 
represent general information about your company, such as company name and 
address. Another data file called Jobs.DAT contains information about your 
company’s jobs, including job IDs, descriptions, and start and end dates. 

For a listing of all available .DAT files and the fields they contain, look up 
“.DAT Files” in Crystal Reports for Peachtree online Help.

Tables and Links

Within the Crystal Reports for Peachtree program, the information contained 
in any of these .DAT files is available in the reports you work on. You import the 
information into Crystal in the form of database tables. 

Not only can you import database information into your report, you can link 
related fields within the database tables you import. These links help you match 
related pieces of information for reporting purposes. For example, links can 
help you match a vendor to the inventory items the vendor supplies.

The following section outlines how to select and link tables used in Crystal 
reports. For more detailed information, see the Crystal Reports User’s Guide, the 
“Understanding Databases” chapter.
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Using JrnlHdr and JrnlRow Tables

The JrnlRow table mentioned below in this chapter is the most important table 
you will use in building customer reports in Crystal. It is the chief primary table 
for Crystal reports, and reports are essentially built by linking it with secondary 
information containing customer, vendor, item, and job data. It contains fields 
that, when linked to the same field in secondary tables, allows the report to draw 
on appropriate Peachtree record information. 

For example, as mentioned below, if the CustomerRecordNumber field in the 
JrnlRow table is linked to the same field in the Customer table, the report will be 
able to draw on customer transaction information. Similarly, if the 
ItemRecordNumber field in the JrnlRow table is linked to the same field in the 
LineItem table, the report will be able to draw on item-activity information, 
such as units-sold figures.

Sometimes the JrnlHdr table can serve as primary table for a report. This is true 
when all information needed to build the report is contained in the JrnlHdr 
report. For example, if you wanted to build an uncomplicated list displaying 
transactions in the Peachtree Payments Journal, you could do so without using 
JrnlRow. The JrnlHdr table contains fields for drawing amount, payee, and 
reference number information into the report, which is all the data needed to do 
the job. In most reports, however, JrnlHdr will be a secondary table linking to 
the JrnRow table as other secondary tables do.

How to Add Tables and Make Links

To add linked database information to your report, follow these steps:

1 Select the Database menu, and then select Database Expert. 

The Crystal Database Explorer window appears.

2 Find the Create New Connection folder in the list, and double-click to open 
it.
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3 Double-click the Btrieve option.

4 Double-click the Btrieve option.

5 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.

The window displays the three Crystal Reports for Peachtree DDFs.
Crystal Reports will give

you three DDFs to choose
from in your Peachtree
company folder, but be

sure always to select
File.DDF.
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6 Select File.DDF, and then select the Open button.

While the Open window will show all three DDFs that come with the Crystal 
Reports for Peachtree program, you should always select File.DDF.

7 The Database Expert window returns with the contents of the DDF displayed 
as a series of tables.

These tables correspond to the .DAT files mentioned above, the ones 
containing company database fields. For example, the Chart table contains 
all the company fields present in the Chart.DAT file, and the Employee 
table contains all the payroll fields present in Employee.DAT. 

8 Select as many tables in the list as you want to include in the report. To select 
a table, do one of the following:

• Highlight the table and click the right arrow button.

• Highlight and double-click the table.

9 When finished, select the OK button.

Note
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The Links tab of the Database Expert appears. All the tables you have 
chosen are displayed at the center of the window. If the Smart Linking 
feature is turned on, the Expert automatically links all fields capable of 
being linked. (Using the Smart Linking feature is much the easiest way to 
link fields, but you can do it manually if you like.) 

You can make new links or dissolve old ones as explained in Crystal 
Reports Online Help. For more information, select the Help button in the 
Database Expert window.

The reason you link related fields across tables is so that the data 
represented by the fields can match up in meaningful ways within your 
report. For example, you would probably want to link the 
CustomerRecordNumber field in the JrnlRow database table to the 
CustomerRecordNumber field in the Customer table. This way, 
transaction information for each customer would be credited to the 
proper customer ID in the report.

10 When finished working in the Database Expert, select OK to close it.

If Smart Linking is turned
on, the Database Expert will

automatically make links
between appropriate fields

in the chosen database
tables. You can add or

delete links using the
options in the window.
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Once you have made meaningful links among fields in the database tables, you 
are ready to insert the fields into your report. Using the Crystal Reports Field 
Explorer, you just plug one of the fields into the report wherever you want 
specific database information to appear. For example, to insert a customer ID 
into your report, you would select the CustomerID field in the Field Explorer 
window, then drag and drop the field into your report.

For instructions on working in the Field Explorer, select the Help button at the 
bottom of the window.

We’re Ready to Start the Tutorial...

Now that you understand a bit more about using Peachtree database 
information in Crystal Reports, we can start putting together custom reports. As 
mentioned at the beginning of this chapter, in Crystal Reports you have the 
choice of manually building a report from scratch or of letting the Crystal 
Report Expert step you through the process. In this tutorial, we’ll do both:

• In Lesson 1 we’ll customize an existing standard report, inventory 
labels.

• In Lesson 2 we’ll design a Customer Contact List from the ground up. 

• Finally, in Lesson 3 we’ll use the Report Expert to craft a Quotes by 
Expiration Date List.

To insert a field, 
just select it in 
the Field 
Explorer, then 
drag and drop it 
into the report.
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Lesson 1—Modifying Inventory Labels to Create Price Tags
As a warm-up exercise, we’ll convert one of the standard Crystal reports. We’ll 
turn the inventory labels into price tags that can be attached to sale merchandise.

Use “Save As” to Create a Working Version of the Report

Since the standard reports are read-only versions (you can’t edit them in any 
way), we need to create an editable version of the inventory labels.

1 If Crystal Reports isn’t currently running on your computer, start it now.

2 Select More Files, and then navigate to the BCS folder in the Peachw 
directory; this is where Bellwether Garden Supply company data is located. (If 
Crystal Reports is already running, select Open in the File menu, and then 
navigate to the Bellwether company folder.)
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3 From the list of reports, select Inventory Labels.

4 The message tells you that you cannot write to (edit) the report. Click OK.
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Modify the Labels to Create Price Tags
5 To save the report in editable form, from the File menu, select Save As.

6 In the File name box, enter “Price Tags.” Then select Save.

7 Finally, before starting on the next part of the project, close the report and 
then reopen it.

Modify the Labels to Create Price Tags

We’re now ready to start working on our new creation.

1 Select the Design tab.

Enter the name of the
new report you want to

save.
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2 We won’t need the Vendor ID or Location fields, so place the cursor in the 
gray area that reads “Details d” and right click.

3 From the pop-up menu, select Delete Section.

Working with report sections is an important concept but is beyond the scope 
of this guide. For more information, see the Crystal Reports User’s Guide, the 
“Introduction to Reporting” chapter.

4 We want to keep the section marked “Details c,” so just select the Vendor ID 
field.

 An object frame appears around the field, and the cursor turns into a cross 
with four arrowheads. The field is now editable.

5 Right click, and from the pop-up menu, select Delete.

The field is deleted.

6 Select the Field Explorer button in the Standard toolbar.

7 Double-click the Database Fields folder to open it, and then double-click the 
LineItem table to open it.

Note

Double-click both the
Database Fields folder and
the LineItem table to open
them so you can navigate

their contents.
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8 Find the PriceLevel1Amount field; select it; and drag it into the Detail c 
section. Release the mouse button. You can close the Field Explorer window.

9 Now we want to modify the font used for the Description field. Select the 
field, and then right mouse click.

10 From the pop-up menu that appears, select Format Field.

The Format Editor window appears with the Font tab selected.

11 From the Style drop-down list, select Bold.
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12 When finished, select OK.

13 Now let’s change the font of the PriceLevel1Amount field. Select it, and 
right mouse click. Select Format Field.

14 Select the Font tab of the Format Editor, and use the Font drop-down list to 
select Arial (or some other sans serif font you fancy more).

15 Use the Style drop-down list to select Bold.

16 Use the Size drop-down list to select 16 points.

17 Use the Color drop-down list to select Red. When finished, select OK.

18 With the PriceLevel1Amount field still selected, click the Align Left button 
in the Standard Toolbar at the top of the window.

19 Next we want to insert an “Our Price” marker. Select the Insert Text Object 
button in the Standard toolbar, and then drag the object frame to the far left 
side of the Detail c section. (We’ll discuss object frames in further detail in the 
next lesson.)

20 Click once to place the frame in the section.

21 A text cursor appears at the right side of the object frame. Type in the 
following: “Our Price: $.”

22 Select the object frame, and then right click. From the pop-up menu select 
Format Field. Now make the font settings exactly as in steps 11 through 16.
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23 The text will probably appear a bit cut off at the bottom, so select the bottom 
frame handle (the small black square at the top of the frame), and drag it 
downward until you can see the text plainly.

24 Select the object frame, and move it up so that it more or less aligns with the 
PriceLevel1Amount field.

25 To make more precise adjustments, we need to go to the Preview tab.

Select the frame
handle to change the
size of a frame. The
cursor will turn to a

double-headed
arrow.
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26 Our labels look pretty good already, but first we need to expand the “Our 
Price” object frame so that the dollar sign shows, making sure that there is a 
slight space between the “Our Price” object frame and the 
PriceLevel1Amount object frame. Select the first “Our Price” object frame 
in the window. When the frame handles appear, click on the one at the right 
side of the frame, and drag the frame to the right.

27 The “Our Price” field is rather far away from the dollar sign, so let’s close up 
the space. Select the PriceLevel1Amount field (in the illustration above, it 
would be the 129.99 value). When the object frame appears, click the Align 
Left button in the standard toolbar at the top of the window. 

This way, if the PriceLevel1 field has a large value in it (1,000.00 or more), 
the field will expand to the right to accommodate the longer string of 
numbers. Our price tags are now complete.

28 Finally, from the File menu, select Save As, and save the report under the 
name “Price Tags.”

Review of Lesson 1

Let’s review some of the ideas we covered in Lesson 1:

• Since the standard reports that come with Crystal Reports for 
Peachtree are read-only, if you want to customize one of the reports, 
you must first save it under a new filename.

• When you are working with data fields within a report, select them and 
right click to see a pop-up menu that lets you format, delete, and copy 
fields, as well as perform other functions.

• To insert data fields, use the Field Explorer button in the Standard 
toolbar. To insert text fields, use the Insert Text Object button in the 
same toolbar.

When you increase
the width of the

“Our Price” object
frame, make sure

there is a slight space
between the two

object frames.

Compare this
illustration with the

one above. Note that
the 129.99 value has
moved to the left as a

result of left
alignment.
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Review of Lesson 1
• To move a field, first select it. The cursor will change into a cross with 
four arrowheads, indicating that you can now manipulate the frame. 
To move the frame, simply drag and drop it. 

• To expand or contract an object frame, select the frame; click the 
appropriate frame handle (at either right, left, top, or bottom of the 
frame); and then drag and release the frame.
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Lesson 2—Designing a Customer Contact List

The second lesson covers the design of a contact list you can use to help keep 
track of your customer base. It will list customer company name, contact name, 
and phone.

Select the Report Database

First we need to select the tables whose database information we’ll use to build 
the report.

1 If Crystal Reports isn’t currently running on your computer, start it now. (If 
Crystal Reports is already running, select New in the File menu.).

2 In the Create a New Crystal Report Document box, select As a Blank 
Report, and then select OK.
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Select the Report Database
3 In the Database Expert, double-click the Btrieve folder.

4 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.

5 From the list of Peachtree DDFs, select File.DDF, and then select the Open 
button.

6 From the list of displayed tables, select Customers; either double-click it or 
select the Right Arrow button.

7 When finished, select OK.
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8 From the Standard Toolbar, select Field Explorer.
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Select and Insert Fields

Now we want to place the appropriate fields in exactly the right spots within the 
report.

1 Double-click Database Fields and then Customers.

2 From the list of customer fields, select Customer ID, and then drag it to the 
far left of the Details section of the Report Designer. 

An object frame with the cursor shaped like an arrow appears as you drag 
the field.

3 To insert the field, release the mouse button.

The column header text,
underlined, appears in the

Page Header section
above the field name. This
is how the column header
will appear on the printed

or previewed report.
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Note the following:

• The object frame indicates that when the report is either printed or 
previewed, the field value will appear where the field name now 
appears.

• The width of the object frame indicates the maximum allowable width 
of the printed or previewed field. It is set to display the maximum 
number of characters in the field, but you can change this by resizing 
the object frame.

• The field name is repeated above, underlined, in the Page Header 
section. This represents the column header text for the field and is how 
the header will appear on the printed or previewed report.

• The font and style used in displaying both the field value and the 
column header indicate the font and style selected for the characters 
that appear in both these elements. Later, we’ll tell you how to change 
the font and style of text characters.

4 Now we want to add two additional fields to the report. In the Field Explorer 
window, select the Contact field; press the Ctrl key; and then select the 
Phone_Number field. Drag the fields and place them to the right of the 
CustomerID field.

As you drag the fields, an object frame appears with the cursor shaped like 
an arrow atop stacked sheets of paper marked with a plus. This indicates 
that you are inserting multiple fields at once.

5 Click the mouse button to insert the fields.

The fields appear in the same order in which you selected them in the Field 
Explorer window, namely, Contact followed by Phone_Number.
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Select and Insert Fields
6 Next we want to place the company name at the top of the report. In the 
Field Explorer window, select Formula Fields, and select the New button.

The Formula Name window appears.

7 Type in “Company Name,” and then select the Use Editor button.

The Formula Workshop window appears.

8 In the middle panel, double-click the Functions icon to expand the list of 
function categories. Find and double-click Additional Functions to further 
expand the list
45



Designing Crystal Reports: A Tutorial
Crystal Reports for Peachtree Getting Started Guide3
9 Find and double-click the peach (u2lpeach.dll) icon.

This expands the list to display the list of custom Peachtree functions. The 
functions marked “v2” are Crystal Reports for Peachtree Version 9 custom 
functions. 

10 Double-click the function GetPeachCompanyNamev2.

This is the function that will display the company name when placed in a 
formula and then applied to a report.

11 Select the Close button in the upper left corner of the Formula Editor. 

In the middle panel, select
Functions>Additional

Functions. Then double-
click the peach

(u2lpeach.dll) icon.
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Select and Insert Fields
The Company Name formula appears in the list of formulas in the Field 
Explorer window.

12 Drag the field to the Report Header section, and click to place it at the top of 
the section, centering it within the section.

The field name aligns with the left side of the object frame.

13 To center the field name so that the company name is centered on the 
printed or previewed report, select the object frame and then select the Align 
Center button in the Formatting toolbar.

The formula name is now centered in the object frame, indicating that the 
formula will be centered on the printed or previewed report.

To center the company
name, select the object
around the Company

Name formula, and then
select the Align Center

button in the toolbar.
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Title and Preview the Report

Finally, we want to add a title to the report. To do so, we’ll need to slightly 
increase the size of the Report Header section. 

1 Place the cursor on the dividing line between the Report Header and Page 
Header sections.

The cursor now has double arrows, indicating that you can use it to move 
the divider between sections.

2 Hold down the left mouse button, and move the dividing line down perhaps a 
quarter of an inch, just enough to insert the report title.

3 To insert the title, click the Insert Text Object button in the Standard 
toolbar, and drag the cursor to the space just below the Company Name 
formula. Click the mouse button.

An object frame appears with the text cursor at the left side of the frame.

4 In the object frame, type “Customer Contact List.”

The cursor with double
arrows indicates that you can
now move the section divider
up or down, thus increasing
or decreasing the size of the

section
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Title and Preview the Report
5 Next, let’s center the title just as we did the Company Name formula. Select 
the object frame around the report title, and then click the Align Center 
button.

The text appears centered within the object frame.

6 Now we want to change the font and style of the report title. Select the 
object frame around the title, and then right mouse click.

7 From the pop-up menu that appears, select Edit Text.

8 When the text cursor appears, select the “Customer Contact List” text to 
highlight it, and right mouse click again.

9 From the pop-up menu that appears, select Text Formatting.
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The Text Format window appears with the Font tab selected.

10 From the Style drop-down list, select Bold.

11 From the Size drop-down list, select 18 points.

12 From the Color drop-down list, select Maroon.

13 When finished, select OK.

14 The title will be a bit off center, so select the object frame; drag it to center it; 
and then release the mouse button.
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Title and Preview the Report
15 Now let’s preview the report to make sure it will look all right when printed. 
Do one of the following: 

• From the File menu, select Print Preview.

• From the Standard toolbar, select the Refresh button.

A new tab, the Preview tab, appears. It shows how the report will look in 
printed form.

To make any desired changes, such as changing the placement of fields for a 
more esthetically pleasing effect, select the Design tab, and work with the fields 
there. As you learned in Lesson 1 (page 37), it’s possible to change report 
elements on the Preview tab, but it’s generally easier working on the Design tab.

16 Finally, from the File menu, select Save As, and save the report under the 
name “Customer Contact List.”
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Review of Lesson 2

Let’s review some of the ideas we covered in Lesson 2:

• Use the Database Expert window to connect with the DDF that 
contains the database tables you want in your report. Use this window 
also to find and select the tables you want to include. (If you add more 
than one table to the report and have the Smart Linking feature turned 
on, which is recommended, Crystal Reports will automatically link the 
selected tables for you where linking is possible.)

• To add fields to the table, use the Field Explorer to find and select the 
appropriate fields within the included database tables. You can select 
multiple fields by highlighting the fields and then selecting the Ctrl 
button. 

• To resize any of the sections in the report, just select the section divider, 
and holding down the left mouse button, drag the divider to the 
position you want.

• To center text within an object frame, use the Align Center button.

• To add text to the report, use the Insert Text Object button

• To change the font properties of a text object, select the object and right 
mouse click. From the pop-up menu, select Edit Text Object. 
Highlight the text; right click again; and select Change Font. When the 
Font tab of the Text Format window appears, make the appropriate 
changes.

• To preview a report before printing, select Print Preview from the File 
menu, or select the Refresh button in the Standard toolbar.
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Lesson 3—Designing a Quotes Good Through List
The third lesson covers the design of a list of quotes issued to customers 
arranged by good-through (quote expiration) date. The report will list the initial 
date of the quote, the customer, the quote amount, and the good-through date.

To show more of the design capabilities of Crystal Reports, this time we’ll let the 
Report Wizard guide us.

Use the Report Wizard to Build the Report

1 From the File menu, select New.

2 In the Create a New Crystal Report Document box, select Using the 
Report Wizard. 

3 Note that in the Choose a Wizard box, Standard is preselected. This is what 
we want, so click OK.
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The Standard Report Creation Wizard starts with the Data window.

4 Double-click the Create New Connection folder to open it, and then 
double-click Btrieve.

5 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.
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6 From the list of Peachtree DDFs, select File.DDF, and then select the Open 
button.

7 From the list of displayed tables, select JrnlRow; then select the right arrow 
button. 

The table appears in the Selected Tables box on the right.

8 Repeat for the JrnlHdr and Customer tables.
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For Smart Linking to work properly, selection order is very important, so be sure 
to select tables in the prescribed order: JrnrlRow, JrnlHdr, Customer.

9 When finished, select Next.

The Links window appears, asking you to link the tables as needed. 

10 With Smart Linking turned on (which is the default), the Expert has linked the 
PostOrder field in the JrnlHdr and JrnlRow tables and the CustomerRecord 
fields in the JrnlRow and Customers tables. Accept these links by selecting the 
Next button at the bottom of the window.

Note
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Use the Report Wizard to Build the Report
The Fields window appears.

11 In the Available Fields box, double-click the Customer table if it is not 
already open. Select the CustomerID field, and then click the Right Arrow 
button.

The CustomerID field moves to the Fields to Display box at the right side 
of the window.

12 In the Available Fields box, double-click the JrnlHdr table to open it. Press 
the Ctrl key, and select the GoodThruDate, QuoteIDForSales, Transaction 
Date, and MainAmount  fields, and then click the Right Arrow button.

13 Use the Up and Down Arrow buttons above the Fields to Display box to 
place the fields in the following order (if they aren’t already):

• GoodThruDate

• CustomerID

• QuoteIDForSales

• TransactionDate

• MainAmount
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14 When finished, select the Next button.

15 We want to group our data by the GoodThruDate field, so select it in the 
Available Fields box, and then click the Right Arrow button.

Use the Up and Down
Arrow buttons to

change the order of the
fields, if needed.
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16 The preselected sort order is acceptable, so select the Next button.

17 We want to include summary information to appear on our report, and the 
Summaries window lets us do this. The Wizard has intelligently preselected 
the MainAmount field as the field to summarize. Select the Next button.
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18 The Group Sorting window lets us sort groups based on summarized totals. 

This could be useful if we wanted to see, for example, which sales rep made 
the most sales in a month, but for our current report sorting is not important. 
So select the Next button without making any changes to the settings.
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19 Again, a chart would be valuable for visually representing sales per sales rep 
or per geographic area, but for our report charting is not important. So select 
Next without choosing a chart option.

20 In the Record Selection window (shown after step 21 below), we want to 
make sure that only quotes appear in our report. To do so, in the Available 
Fields box, double-click the JrnlHdr.Dat (Btrieve) folder to open it; then 
double-click the JrnlHdr table to open it. In the list of fields, select 
JrnKey_Journal. This will tell Crystal that of all the company information 
contained in the journal header file, we want only quote information to 
appear in the report. Finally, click the Right Arrow button. 
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21 From the drop-down list immediately underneath the Filter Fields box, select 

is equal to. And in the other drop-down list box that appears, type 12.

22 Now, repeat steps 20 and 21 for the DistNumber field. In the Available 
Fields box, double-click the JrnlRow table to open it. Select DistNumber, 
move it to the Filter Fields box on the right side of the window, and then 
select the is equal to parameter from the first drop-down list. But in the 
second drop-down list box, type 1, as shown below. 
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23 When finished, select Next.

The last window, the Template window, lets you add a little predesigned 
pizzazz to your report. To familiarize yourself with the available templates, 
click each to see a preview. However, for our current report we want a plain 
format, so we’re going to stick with the No Template option. 
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24 Select Finish to see the completed Quotes Good Through report.

Notice that the report is displayed on the Preview tab to show what it will 
look like when printed. To achieve the look seen above, you may need to 
make minor adjustments to the column headings. For information on how 
to do so, see the Crystal Reports User’s Guide, the “Quick Start” chapter.

25 Finally, select the Save button in the Standard toolbar, and save the report 
under the name “Quotes Good Through List.”

26 Now test your memory. Insert the “Bellwether Garden Supply” company 
name on the report. If you don’t remember how, consult the section of Lesson 
1 where we discuss putting the company name on a report.

Filter the Report

Finally, we want to add a parameter field, which will make the report more useful 
by limiting the amount of data displayed. The parameter field we want to add 
will filter the GoodThruDate field by a cutoff date so that no quotes with an 
expiration date earlier than the cutoff date will appear on the report.

For step-by-step 
instructions on 
using parameter 

fields, look up 
“Parameter Fields” in 
the Crystal Reports 
Online Help index.
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1 in the Standard toolbar, select the Insert Fields button. 

2 When the Field Explorer window appears, select Parameter Fields and right 
click. From the pop-up menu, select New. 

3 In the Name field, enter “QuoteExpirationDate.”

4 In the Prompting text field, enter “Enter desired Quote Good Through 
Date.”

5 In the Value type field, use the drop-down list to select Date.
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6 Click the Set default values button.

The Select or enter value to add box displays the current date (the system 
date from your computer). Since we want to limit the expiration date for 
quotes listed on the report to April 1, 2007, we want to select that date and 
then make it the default date for the report.

7 In the M/D/YYYY field, use the drop down list to display a calendar. 
Navigate through the calendar until you find April 1, 2007, and then select it.

8 Now, click the Right Arrow button next to the field to populate the Default 
values box with this date.
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9 When finished, click OK twice.

10 Next, we want to create a report selection formula that will filter the report to 
show quotes that fall before the expiration date of April 1, 2007. From the 
Report menu, choose Selection Formulas  and then Records.

The Record Selection Formula Editor appears.

11 Place the cursor on the last line of formula, which should read 
{JrnlRow.DistNumber = 1}. Type a space and then the word “and.” Press 
Enter to go to the next line.

12 In the panel on the left side of the window, double-click the Reports Fields 
icon to open it, and then double-click the GoodThruDate field. It will appear 
as part of the selection formula. Type a greater than (>) sign after it.

13 Next, select the Report Fields icon at the top of the left panel; then find and 
select (double-click) the ?Quote Expiration Date field. It should appear as 
part of the selection formula; see below.

14 The formula is now complete, so select Close to close the Record Selection 
Formula Editor.

A message appears asking “Do you want to save your changes?”

15 Click Yes.

Select fields here...

...and edit the formula here.
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16 When the Enter Parameter Values window appears, accept the default by 

clicking the OK button.

Since we have previously saved the report, a message appears telling us that 
Crystal has detected a change.

17 Select the Refresh Data option.

18 Now select Save again to save the final version of our report.
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Review of Lesson 3

Let’s review some of the ideas we covered in Lesson 3:

• The Standard Report Creation Wizard lets you choose the database, 
database tables, and links that will operate in the report much as you 
would do if you had started with the Database Expert.

• The Fields window of the Wizard lets you add fields to the report and 
also select the order of those fields and the column headings that will 
identify them in the report.

• The Grouping window lets you group all information in the report by 
one or more of the chosen fields.

• The Summaries window lets you choose a field or fields that will 
provide summary information in the report. It also lets you chosen 
whether or not to include a grand total as part of the summary 
information.

• The Group Sorting window lets you sort groups based on summarized 
totals. This could be useful in the case of reports reflecting information 
such as sales, where you will want to track sales reps or units doing the 
best business.

• The Chart window lets you add a chart to the report, a visual 
representation of facts and figures in the report.

• The Record Selection window lets you use one or more of the fields to 
filter the information that appears on the report. This will limit the 
amount and nature of data you see.

• The Template tab lets you overlay your report with a predesigned 
template, to give your report added flair.

• If you want to further limit the data appearing on the report, adding 
one or more parameter fields to the report will be the answer. Go to the 
Field Explorer, select Parameter Fields, right click, and select New.
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• Upgrading Crystal Reports to 
Peachtree 2004 •

Overview

If you used Crystal Reports for Peachtree with a prior release, you need to 
update your customized reports to the new Peachtree 2004 data formats. (This 
essentially allows you access to new or modified data fields introduced in 
Peachtree 2004.) To learn how to quickly update your customized reports, look 
up “convert, custom Crystal reports to new Peachtree Release format” in the 
Peachtree Help index.

If you have upgraded to Peachtree Accounting, Peachtree Complete 
Accounting, or Peachtree Premium Accounting 2004 but have not upgraded 
Crystal Reports for Peachtree from Version 8, your custom Crystal reports will 
work with Peachtree following data conversion. However, if you have upgraded 
to a version of Peachtree 2004 and upgraded to Crystal Reports for Peachtree 
Version 9, you will also need to verify the data source location for your custom 
reports before converting report data to Version 9 format.

The instructions that follow cover both instances. Complete these instructions, 
and you should be using your custom Crystal reports in no time. Before we 
discuss upgrading, however, we want to note three changes in Version 9 of 
Crystal Reports for Peachtree, two of which impact working with reports.

Join Type

One important change noted in these instructions is that the default join type 
for linking tables has changed in Version 9. In Version 8, the default join type 
was Left Outer Join. The default type in Version 9 is Inner Join, which we 
recommend you not use. Because it provides links between same-name fields in 
report tables, using the Inner Join type results in tables with a minimum of 
linkages and no redunancy. However, this join type can also result in reports 
that are missing important data, so you should always set up your reports to 
have links of the type Left Outer Join. Note that these two join types are the only 
ones available in Crystal Reports for Peachtree.

For more information on join types, look up “linking options” in the Crystal 
Reports Online Help index.

Note
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Relative Datapath

As noted in the instructions that follow, Version 9 of Crystal Reports for 
Peachtree requires that all custom reports be in the same datapath as the 
company files they draw on for their data. To make sure that a report will always 
be able to access the right company data, you need to set the relative datapath 
for the report. Follow these steps:

In Crystal Reports for Peachtree, open the report.

1 From the Database menu, select Set Datasource Location.

The Set Datasource Location window appears.

2 In the Current Datasource box at the top of the window, double-click the 
Properties icon to see the list of report properties.

3 Right-click on the Data File line, and from the pop-up menu, select Edit.

4 Edit the selection so that it reads “Data File: ./FILE.DDF.” 

5 Press the Enter or Tab key.

Once a report is saved with the relative datapath of ./FILE.DDF, you can move 
it to any company folder, and you will be able to use it for that company without 
having to reset the datasource location.

Repository Explorer

In the Crystal Reports for Peachtree Version 9 Design window, you will notice a 
button called the Repository Explorer button. It opens the Repository Explorer 
window, a feature that is discussed in Version 9 documentation. This feature 
does not work with Peachtree 2004. If you open the Repository Explorer while 
working in a Crystal report, you will see no data in the window. Please ignore 
this feature and references to it the Crystal Reports User’s Guide and Crystal 
Reports Online Help.
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Upgrading to Peachtree 2004 Using Crystal Reports for 
Peachtree Version 9

When you convert to Peachtree 2004 and Crystal Reports for Peachtree Version 
9, the company folders for companies created in older releases of Peachtree will 
contain standard Crystal reports in both Version 8 and Version 9 formats. 
However, if you create a new company through new company setup in 
Peachtree 2004, your company folder will contain only Version 9 standard 
Crystal reports. Also, the Peachtree 2004 sample companies (such as Bellwether 
Garden Supply) contain only Version 9 standard reports. Version 9 standard 
reports are marked with a “v9” notation (for example, Customer Detail List v9).

If you are upgrading Peachtree 2004 and upgrading to Crystal Reports for 
Peachtree 9, there is an important initial step you should take to make sure your 
custom reports will work properly. After you complete the step, you can follow 
the instructions outlined under “Upgrading to Peachtree 2004 Using Crystal 
Reports for Peachtree Version 8” on page 77.

Verify and Set Data Source Location

Version 9 of Crystal Reports for Peachtree requires that the report you are 
working with is in the same datapath as the company files it draws its data from. 
If it is not, wrong or missing data will show up in the report, so you must verify 
that your custom report is indeed in the right datapath. Follow these steps:

1 Open the appropriate company in Peachtree, and from the Reports menu, 
select Crystal Reports.

2 From the Report List box, select the custom report you want to convert.

3 Click OK to proceed; the selected report appears.

If the current datasource location matches exactly the datapath location of 
your custom report, or if the datasource location is set to .\FILE.DDF, you 
can skip to step 5.

Note
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4 From the Database menu, select Set Datasource Location.

The Set Datasource Location window lets you change the location of the 
current data source (that is, the DDF file) for the report. This might be 
necessary for a number of reasons, including

• the report has been copied into the company directory of a new 
company

• you have newly installed Peachtree and have backed up your 
company data into a dummy company

• the company data has been moved to a new machine with a 
different datapath

5 In the Replace with list box, click Btrieve to open the folder. The Find 
Database File icon appears.
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6 Click Find Database File to locate the datapath where the Peachtree 2004 
data source is located. When you find the proper data source, select it.

7 The Update button becomes available. Select it, and then select Close.

The data source location has now been established and the database 
verified for the report. Since verification has already occurred, proceed to 
“Map Unmapped Fields” on page 78. 
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Upgrading to Peachtree 2004 Using Crystal Reports for 
Peachtree Version 8

If have upgraded to Peachtree 2004 and are using Version 8 of Crystal Reports, 
basically you have two tasks to complete: verifying the database and 
reestablishing links among database tables.

Verify the Database

1 Open the appropriate company in Peachtree, and from the Reports menu, 
select Crystal Reports.

2 From the Report List box, select the custom report you want to convert.

3 Click OK to proceed; the selected report appears.

4 From the Database menu, select Verify Database.

Crystal Reports automatically compares the database tables used in the 
custom report with tables used by Peachtree 2004. It compares field names 
in the existing tables with names used in the new tables and then maps the 
fields. If any fields remain unmapped—that is, the field names don’t 
match—Crystal lists the unmapped fields and invites you to map them.
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Map Unmapped Fields

In the illustration that follows, we are updating the Customer Detail List 
report. We’ve selected Verify Database, and Crystal has found that four 
fields in the report remain unmapped to fields in the new database table. 
These three fields from the Customers table appear in the Unmapped 
Fields list box on the left side of the window. 

1 To map a field, select it in the Unmapped Fields box, and then find its 
equivalent in the list box on the right side of the window. In the case of the 
first unmapped field, Bill_Name, the field name has changed for Peachtree 
2004. It is now called Customer_Bill_Name. So you would select that field in 
the list box on the right side of the window.

The Map button now becomes available.

2 To map the fields, select the Map button; keep the Match type check box 
checked.

In the list box on the right
side of the Map Fields

window, select the new
field name that you want

to map to. The Map
button becomes available.
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The old field is now matched to the new one, as seen in the two Mapped 
Fields list boxes at the bottom of the window.

3 Repeat steps 5 and 6 for any other fields that remain unmapped.

Note that you don’t have to map every field; some fields may not have new 
equivalents that need to be matched to them.

4 When finished, select OK to return to the report.

Relink Database Tables

Now that all fields are properly mapped, you’re ready to make sure that links 
between database tables are valid and in place. If links are not valid, Crystal 
Reports issues an error message at this point. But even if you don’t see a 
message, it’s always a good idea to make sure all links are in place. 

This is true if your custom report contains account numbers or employee IDs. 
In older versions of Peachtree, the Chart and Employee tables were linked using 
employee IDs. In Release 2004 of Peachtree, however, the links are established 
using employee record numbers. So if you are upgrading from an older version of 
Peachtree links to the Chart and Employee tables will certainly be broken.

To relink the tables, follow these steps:

The formerly unmapped
Bill_Name field is now

mapped to the new
Customer_Bill_Name field.
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1 From the Database menu, select Database Expert.

The Data tab contains a list of data sources you can add to the database 
tables for the report. In the illustration below, we are still working on the 
Customer Detail List. We need to add the Chart database source to the 
report’s database tables, so we have selected it in the Available Database 
Sources list box.

2 In the Database Expert, select the database source you want to add to the list 
of tables, and then click the first arrow button to the lefts of the Available 
Database Sources list box.

The source moves to the Selected Tables list box.

3 Repeat step 2 to move any needed additional data sources to the Selected 
Tables list box.

4 When finished, select the Links tab.

Select the appropriate
database source here...

...and then click the 
arrow button to move 
it to the Selected 
Tables list box.
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This tab displays the links between the database tables. In our example, the 
Customer Detail List, note that links have been reestablished between the 
Customers table and the Chart and Employee tables.

5 Even though the links are in place, next you need to make sure the link types 
are correct. Select a link line, and then select the Link Options button.

The links between the 
Employee and 
Company tables are 
invalid and need to be 
removed.
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The Link Options window shows the type of link that exists between the 
tables. The default join type for Version 9 of Crystal Reports for Peachtree 
is Inner Join, but for your custom reports you should always choose 
instead Left Outer Join as the join type.

6 Select the Left Outer Join option button. Then select OK to return to the 
Database Expert.

7 Repeat steps 5 and 6 for each link whose type you need to change.

Next, check also that there are no inappropriate links between tables. In 
the detail of Database Expert Links tab shown below, note the links 
between the Employee and Company tables.
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Since the example we’re using is the Customer Detail List, the report 
doesn’t need to draw on employee record fields such as employee’s street 
address, e-mail address, and phone number. So these links need to be 
broken. 

8 If there are any inappropriate links between tables, select one of these links 
and right-click. From the pop-up menu, select Delete Link. Repeat for each 
link that should not exist.

9 When finished, select OK to accept the changes and return to the report.

If you are upgrading to Version 9 of Crystal Reports for Peachtree, at this 
point you will see a message that reads “The database is now up to date.” 
Click OK to dismiss the message; then proceed with step 10.

10 You’re ready now to refresh the data. Select the Refresh button.

11 In the Refresh Report Data window, select Prompt for new parameter 
values.

12 In the Enter Parameter Values window, use the End of range drop-down list 
to select the very end of the range; it will be represented by a series of z’s, as 
in the example below.

13 Select OK to accept the setting and return to the report.

Note
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You should now be ready to work with your custom report in Peachtree 
2004. 

However, in some cases you will see an error message stating that one of 
the functions you used in putting together the report is not valid in this 
version of Crystal. 

• If you are still working with Crystal Reports for Peachtree 
Version 8, the old report functions will actually still work, so you 
can disregard this message. Click OK to dismiss it.

• If you have upgraded to Version 9 of Crystal Reports for 
Peachtree, you need to follow the steps below to replace the old 
report function with a new one compatible with Version 9.

Replacing Old Report Functions in Crystal Reports for 
Peachtree Version 9

The Invalid Function window shown above indicates that one of the custom 
formulas in your report will not work in Crystal Reports for Peachtree Version 
9. The reason is that one or more of the functions used to set up the formula has 
changed in the new version. The window in the illustration informs us that the 
function GetPeachCustomFieldHeading is not supported in Version 9 and 
must be replaced with the current function. The new function is marked with 
“v2” (GetPeachCustomFieldHeadingv2), indicating it is a Version 9 function.

For more information on working with formulas and functions, refer to the 
“Using Formulas” chapter of the Crystal Reports User’s Guide. For information on 
custom Peachtree functions and how to use them in report formulas, look up 
“custom Peachtree functions (Crystal Reports)” in the Peachtree online Help index.

Copy the New Function and Paste into the Custom Formula

1 You need to copy and paste a version of the current function into your 
custom formula. So click the Copy to Clipboard button to copy the function 
to the Windows Clipboard.

2 Click OK to dismiss the message.

The new function is
marked with “v2” to
indicate it’s a Crystal

Reports for Peachtree
Version 9 function.
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3 In the Crystal Reports Design window, select the Design tab.

4 Select the formula for which the custom function needs replacing. 

5 Right-click, and from the pop-up menu, select Edit Formula.

The Formula Workshop window appears showing the old function that 
needs to be replaced.

6 Use the mouse pointer to highlight this function, and then press Ctrl+V to 
paste the current (Version 9) function into the custom formula.

For certain functions, you may have to enter parameters or edit the syntax 
of a function. In these cases, you would receive a message: “There is an 
error in this formula. Do you want to save it anyway.” Click No, and add 
any necessary parameters.

For more information on editing functions, look up “functions, Peachtree in 
Crystal Reports” in your Online Help index.

7 When finished, select Save to save the formula; then select Close.

8 The Invalid Function error message may appear for additional old functions 
that need to be replaced. Repeat steps 1 to 4 to replace all functions that 
need it.

Once all old functions have been replaced, your custom report is ready to 
go in Crystal Reports for Peachtree Version 9.

Highlight the old
function, and then

paste the new one in its
place.
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• Linking Report Tables in Crystal 
Reports for Peachtree Version 9 •

Overview
If you are working with Version 9 of Crystal Reports for Peachtree, you may find 
that report tables do not Smart Link (autolink) exactly as they did in Version 8. 
This is true because some tables are no longer used, and the function of some 
has changed. This chapter discusses the tables used to generate Peachtree 
custom reports and the fields that should be used to link them.

For more information on linking databases, refer to the “Understanding 
Databases” and “Crystal SQL Designer” chapters of the Crystal Reports User’s 
Guide.

Peachtree Report Tables and Linking Fields
The following is a list of tables used for building Peachtree custom reports. Some 
do not function as they did in Version 8, so before linking tables manually in the 
Crystal Database Expert, be sure to consult this chapter of Getting Started. 

The tables are listed in alphabetical order, but perhaps you’ll want to look at 
“JrnlHdr” and “JrnlRow” first. These two tables are the two most important for 
report building, and all other tables must link to them before data can show up 
properly in reports.

Audit Trail

The Audit Trail table has no indexed fields, or “keys”, and only one field that can 
link to another table. You can link the PostOrder field to JrnlRow or JrnlHdr.

For more information on indexed fields, look up “indexed fields” in the Crystal 
Reports Online Help index.

Chart

If your report lists some or all of the accounts your company’s chart of accounts, 
then the Chart table will be the primary table involved. Otherwise, it will be a 
secondary table linked to others by the GLAcntNumber field.
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Company

The Company table is not used in building reports in Version 9. In this version, 
special custom functions, not a table, are used to insert company information 
into the report.

Cost Code

Except in reports merely listing cost codes, this table is a secondary one. It has 
several indexed fields, the primary ones being CostRecordNumber and 
CostCodeID.

• With JrnlRow as the primary table, the Cost Code table links to the 
CostCode field by the CostCodeID field.

• With JobEst as the pimary table, the Cost Code table links to the 
CostCode field by the CostRecordNumber field.

Customer

Except in reports including a customer list, this table is a secondary one. The 
most important indexed field in the table is CustomerRecordNumber, which 
you should use to link the Customer table to primary tables (JrnlRow or 
JrnlHdr).

Employee

Except in reports including a employee list, this table is a secondary one. The 
most important indexed field in the table is EmpRecordNumber, which should 
be used to link the Employee table to primary tables (JrnlRow or JrnlHdr).

General.DAT Tables

The General.DAT file is made up of five individual tables, listed below.

General_AP

This table has no indexed fields. Instead, it has a number of account record 
number fields that should link to the Chart tables in Chart.DAT through the 
GLAcntNumber field. The account record number fields in General_AP will 
not SmartLink to this field in the Chart tables, but you can link them manually 
in the Database Expert.
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If you want more than one account number to appear in a report, for each 
additional account you want to show you need to set up a separate alias of the 
Chart table and link to it from the General_AP table. The illustration below 
shows these links to alias version s of the Chart table.

For more information on working with aliases, refer to the “Understanding 
Databases” chapter of the Crystal Reports User’s Guide, or look up “alias” in the 
Crystal Reports Online Help index.

General_AR

This table has no indexed fields. Instead, it has a number of account record 
number fields that should link to the Chart tables in Chart.DAT through the 
GLAcntNumber field. The account record number fields in General_AR will 
not SmartLink to this field in the Chart tables, but you can link them manually 
in the Database Expert.

As with the General_AP table, in order to show more than one account number 
you must set up alias versions of the Chart table and link them to the 
General_AR table in the manner shown in the illustration above.

General_GL

This table has no indexed fields. Instead, it has a number of account record 
number fields that should link to the Chart tables in Chart.DAT through the 
GLAcntNumber field. The account record number fields in General_GL will 
not SmartLink to this field in the Chart tables, but you can link them manually 
in the Database Expert.

As with the General_AP table, in order to show more than one account number 
you must set up alias versions of the Chart table and link them to the 
General_GL table in the manner shown in the illustration above.

Note
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General_Inv and General_Jobs

Neither of these tables has fields that can be linked to other tables during report 
building.

Peachtree Report Tables (Continued)

Jobs

Except in reports including a list of existing jobs, this table is a secondary one. 
The most important indexed field in the table is JobRecordNumber, which 
should be used to link the Jobs table to primary tables (JrnlRow or JrnlHdr).

JrnlHdr

In some reports, the JrnlHdr can act as the primary table. If all information 
needed in the report is contained in the JrnlHdr table, then the JrnlRow table 
(usually the primary table for a report) is not needed, but JrnlHdr will link to all 
secondary tables.

If JrnlRow contains needed report information, then JrnlRow will be the 
primary table. JrnlHdr will be a secondary table linking to JrnlRow through the 
indexed field PostOrder.

JrnlRow

Except as noted above under “JrnlHdr,” JrnlRow is always the primary table and 
provide core database information for report building. JrnlRow contains the 
raw data making up accounting transactions. In all reports that need to include 
transaction data (except when JrnlHdr contains all fields needed to build the 
report), JrnlRow will serve as primary table, and all other tables will be 
secondary. JrnlRow should never act as a secondary table.

LineItem

Except in reports including a list of inventory items, this table is a secondary 
one. The most important indexed field in the table is ItemRecordNumber, 
which you should use to link the LineItem table to primary tables (JrnlRow or 
JrnlHdr).
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Raise History

This is a new table introduced for use with Crystal Reports for Peachtree Version 
9. It is used only in Peachtree Premium Accounting payroll reports. The Raise 
History table should be linked only to the Employee table through the field 
EmpRecordNumber.

Tax Authority

This table has no indexed fields. In general, the table will need only to be linked 
to the JrnlRow table. In such cases, the ID field in the Tax Authority table will be 
linked to the TaxAuthorityCode field in the JrnlRow table.

Tax_Code

This table has no indexed fields. In general, the table will need only to be linked 
to the JrnlHdr table. In such cases, the ID field in the Tax_Code table will be 
linked to the SalesTaxCode field in the JrnlHdr table.

Ticket

This table has no indexed fields. In general, the table will need only to be linked 
to the Employee or Vendor table through the field EmpVendRecordNumber.

Vendor

Except in reports including a list of vendors, this table is a secondary one. The 
most important indexed field in the table is VendorRecordNumber, which 
should be used to link the Vendor table to primary tables (JrnlRow or JrnlHdr).
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• Appendix: Filtering Report Data •

Overview
Certain fields in the JrnlRow and JrnlHdr tables can help you filter your custom 
Crystal reports so that you see exactly the kind of data you want to see. In this 
appendix, you’ll learn which fields are especially useful in this respect and how 
to use them as filters. 

In addition, you can use certain fields to filter your reports for information you 
don’t want to see—for example zero-dollar or void transactions. In order to do 
this, you need to edit the selection formulas for these included report fields. The 
appendix will tell you how to do this also.

For complete listings of the fields contained in Peachtree data (.DAT) files, 
look up “.DAT files” in the Peachtree online Help index.

Filtering Reports Using Specific Fields

The JrnlRow Table

Three fields in the JrnlRow table are especially useful for filtering reports: 
RowNumber, RowType, and Journal.

RowNumber

The RowNumber field is used to order transactions consistently in a report and 
is numbered according to the number of data elements in the individual 
transaction. So you could select RowNumber as the field to link in the JrnlRow 
table. You could then create a selection formula that would tell Crystal which 
specific row in the transaction to draw on. For example, your selection formula 
might set the value of the RowNumber field to zero. The zero value means that 
the report will draw on the “top-most row,” or most basic level of information 
in the transaction. That translates to the dollar amount figure in most 
transactions, such as customer or vendor invoices. 

To set the value of a field like the RowNumber field, you use either the Crystal 
Record Selection Formula Editor or Select Expert. To get to one or the other of 
these two windows

1 Open the appropriate report in the Crystal Design window.

2 From the Reports menu, choose Selection Formulas.

3 Do one of the following:
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• To open the Record Selection Formula Editor, from the Report 
menu, choose Selection Formulas and then Record.

The illustration below shows the Record Selection Formula Editor as it 
appears for the Crystal Void Check Register report (Version 9). Notice 
that the value of the RowNumber field is set to zero. You could simply 
type in a new value in order to draw on other rows of data besides the 
top row in the transaction.

• To open the Select Expert, from the Report menu, choose Select 
Expert.

The JrnlRow.RowNumber tab shows that the RowNumber field is set 
to 0.00. You can either type in a new value or select it from the drop-
down list.

RowType

Similar to RowNumber, the RowType field has a number of valid types, 
including JrnlRowType_Normal, which draws information from basic 
transactions such as invoices, credit memos, and sales orders. Beside 
JrnRowType_Normal, a number of other values are available for this field; they 
are listed in the Peachtree online Help topic for the JrnlRow.DAT.

Note that the value of the
RowNumber field in the
JrnlRow table is zero. To
select a different row of
transaction information,

type in a new value.

Again, the value of the
RowNumber field in the
JrnlRow table is zero. To
select a different row of
transaction information,

type in or select a new
value in the drop-down

list box.
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Journal

The Journal field is very useful since its function is to draw on information in 
the Peachtree journals, such as the General Journal. Below is a table of the valid 
values for this field and the Peachtree journals corresponding to each value.

Just as in the case of the RowNumber field above, you can set the value of the 
Journal field in either the Crystal Record Selection Formula Editor or Select 
Expert. For example, if you set the value of the field to three, then your custom 
report would draw on the Sales Journal for its information.

For instructions on setting the value of a field by creating a selection formula, 
see “RowNumber” on page 94.

The JrnlHdr Table

The JrnHdr table, too, has at least one field that will help you filter reports, the 
TransactionDate field. This field will let you make sure the report contains 
information only for a journal transaction that occurred on a specific date. As 
with other fields discussed above, you can change the value of the 
TransactionDate field in either the Record Selection Formula Editor or Select 
Expert.

Value Peachtree Journal

0 General Journal

1 Cash Receipts

2 Cash Disbursements

3 Sales

4 Purchase

5 Payroll

7 Inventory Adjustments

8 Assemblies

10 Purchase Orders

11 Sales Orders

12 Quotes
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Filtering Reports to Eliminate Null Values
Oftentimes, you won’t want your Crystal reports loaded with empty bits of 
information, including transaction fields for which there is no dollar total, no 
date, or no reference number of some sort (for example, invoice or purchase 
order number.) You can do this by creating special selection formulas for the 
fields you use to build your Crystal report.

Selection Formulas for Filtering Out Null Values

Null Dates For example, suppose you wanted your report to filter out all sales 
order transactions that were lacking a ship-by date. You would set up the report 
to include the ShipByDate field from the JrnlHdr table. Then, in either the 
Record Selection Formula Editor or Select Expert, you would set the value of 
this field so that the report returned only sales orders with non-null ship-by 
dates. In the Record Selection Formula Editor, the ShipByDate field selection 
formula should look like this:

{JrnlHdr.ShipByDate}<>Date(0,0,0)

The result: The report would include a ship-by date from the original Peachtree 
transaction only if that date were greater or less than 0 month/0 day/0 year—in 
other words, non-null.

Null Currency Amounts Similarly, if one of your reports lists your company’s 
inventory items, you could filter out all null occurrences of last unit cost. You 
would do this by including the LastCost field from the LineItem table and 
setting the value of the field so that it would return only non-null values for the 
field. In the Record Selection Formula Editor, the LastCost field selection 
formula should look like this:

{JrnlHdr.LastCost}<>0

The result: The report would include a last unit cost from the original Peachtree 
item record only if the cost were greater or less than zero.

Null Strings You can filter your reports so that transaction fields lacking 
information don’t show up on the report. Let’s say you wanted to filter your 
report so that a reference number would show up only if the original Peachtree 
transaction had a non-null entry for the number. You could do this by selecting 
the Reference field in the JrnlHdr table and setting it so that the report returned 
only non-null values for transaction reference numbers. In the Record Selection 
Formula Editor, the Reference field selection formula should look this: 

{JrnlHdr.Reference}<>””

The result: The report would include the reference number from the original 
Peachtree transaction only if it was not blank.
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In Summary....

To filter null Peachtree transaction records out of your Crystal reports, use the 
following values in your report selection formulas:

• Use 0 to filter out missing currency amounts.

• Use Date(0,0,0) to filter out missing dates.

• Use “” to filter out missing string values, such as transaction reference 
numbers.
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